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bar. You can print this file by selecting the Print command from the File menu. 

Use this guide to troubleshoot any problems you have before contacting 
technical support. In 67% of technical support calls, all problems are fixed 
by: Cleaning the CD-ROM, and updating your Sound and Video card 
drivers. To update your Video and Sound card drivers contact your 
Computers retailer who will supply the drivers or provide advice on 
updating. Drivers are small pieces of software that operate your hardware; 
typically, they install themselves automatically. This service is normally free. 
You should also consult section 7, as it may be relevant to your product.
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1. Introduction

1.1 About Dorling Kindersley

DK titles are available wherever CD-ROMs are sold. New titles will be available on a 
regular basis. For more information, contact us at DK Multimedia, 9 Henrietta Street, 
London, WC2E 8PS.

You may also visit us on the World Wide Web at:

www.dk.com

Or Email us at:

DKMM@DKMM.CO.UK

1.2 About this Read Me file

The information in this file is designed to address most of the problems you may 
encounter when using any multimedia title. If you are having problems with the title, 
please take a look at the items listed in the table of contents to see if your particular 
problem is addressed. If you are still having problems, please call our Technical 
Support number with:

Details of the problem,
Any error messages that were produced, 
The full specification of your computer.



If possible, you should be beside your machine when you telephone.

The numbers in New York, USA are:

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: Support@DK.COM

The numbers in London, United Kingdom are:

Telephone: 0870 0100 350 (this call is not a premium call, it is charged at the current 
national rate)
Fax: 0171 753 7343
E-mail: SUPPORT@DKMM.CO.UK

More help on making the best use of all the features within the title is available once 
you have started the product. Click on the help me (you will also find a reminder of 
some of the main points in this document).

2. CD-ROM problems

2.1 Care of compact discs

Contrary to early reports, compact discs (CDs) are very easily damaged if treated 
carelessly. Such damage has a much greater effect on the digital data of a CD-ROM 
than on the information of a music CD. A dirty or damaged CD-ROM is quite likely to 
malfunction. With CD-ROM drives becoming ever faster and more disc-sensitive, this 
is an increasing problem.

The surface of the disc can quickly gather dirt and is very easily scratched. To protect 
the data from scratches, fingerprints, dust particles, and smears, do not touch the 
readout side (unlabeled side) of the disc or place it face down on a hard surface.

Should the CD become dirty, clean it with a soft cloth lightly moistened with CD 
cleaning fluid or ethyl alcohol, working from the center to the edge. Do not use any 
type of solvent, such as benzene, lacquer thinner, anti-static agents or LP record 
cleaners as they may damage the surface.

Never leave the disc in a place subject to direct sunlight, high temperature or high 
humidity. Recommended storage conditions are:

Temperature: 10ºC to 50ºC (50ºF to 122ºF)
Humidity: 10 percent to 80 percent

2.2 Problems with CD-ROM drives



If the title has problems finding the data files it needs from its CD-ROM, you will see an
error message saying that the file, animation (ani) or wav can't be found. Alternatively, 
you may simply find that the screen goes blue, with white text and you will get an error 
message saying that there is an error reading drive X (where "X" is the letter of your 
CD-ROM drive). To find what has caused the problem, do the following:

1. Check that the CD has been correctly inserted into the CD-ROM drive.
2. Check that the title is looking in the right place for the CD-ROM Drive. If, for 

example, the drive letter has changed as a result of a system change, such as 
adding or removing a Hard Drive or another device, then the title will fail to find its 
CD-ROM drive. 

3. If you have an external CD-ROM drive, ensure that it is plugged in, turned on, and 
connected to your computer. You may need to check the documentation that came 
with the drive.

4. Verify that your CD-ROM drive is MPC-compatible and double-speed or faster 
(Check with your Hardware vendor)

 
If you have problems with the CD vibrating, or making a strange noise in the drive then
you should contact DK Technical Support using the telephone number given at the 
beginning of this file.

If you get an error message saying that there is a problem reading the disc, then you 
should try cleaning the disc and try again. Make sure that you restart the product.

3. Setup and Uninstall notes

3.1 Minimum system requirements

In order to run the title you will require a multimedia computer that meets or 
exceeds the requirements printed on the packaging. 

3.2 If Setup fails with an error message

If the Setup program fails with an error message you should ensure that no other 
programs are running while you try to install the title. You can check this by pressing 
'Alt + Tab'. We have found some Anti Virus software and third party Screen Savers 
interrupt the installation causing it to malfunction. You should disable (not uninstall) 
these programs and try again.

3.3 Uninstall



The CD-ROM contains an Uninstall program that is automatically installed in the 
Dorling Kindersley program group on your computer. If you decide that you no longer 
wish to have the title on your computer, you can use Uninstall to remove it. Simply 
double-click on the "Uninstall' icon then click the 'YES' button. Uninstall does the rest 
for you.

If you cannot locate the Uninstall icon, then you can use the 'Add/Remove Programs' 
wizard. To do this click on the 'Start' menu on the 'Task Bar,' then select 'Control 
Panels.' Double-click on the 'Add/Remove Programs' icon, and then select the 
program you wish to remove from the list. Click on the 'Add/Remove' button and then 
the 'Yes' button.

4. Screen display notes

4.1 Screen resolution and color settings

If you have problems reading Windows System dialog boxes, such as the Print dialog 
box, due to low color contrast between text and background, try setting your display to 
use more than 256 colors. 

The title is designed to look its best in high color modes. We recommend that you use 
16-bit colors or more (if your computer supports this). If your display adapter is not 
optimized for high color modes we suggest you reduce the amount of colors, but do 
not use less than 256 colors. Instructions explaining how to change to more than 256 
colors are given below.

Note: Please write down your display adapter card's settings before you make any 
changes. That way you will be able to revert to your original settings should you need 
to.

1. From the 'Start' menu, choose 'Settings' and then 'Control Panel.'
2. Double-click on the 'Display' icon. A 'Display Properties' dialog box will appear.
3. Click on the 'Settings' tab.
4. Under 'Color Palette,' choose 'High Color (24-bit).' If your display adapter card 

supports 32-bit color, then you could select 'True Color (24-bit)' instead. This should 
allow better quality images to be displayed. However, should performance be 
adversely affected, we suggest you revert to 256 colors. 

4.2 Images appear corrupt

Some color display adapters may display the title images incorrectly. If this happens, 
you should upgrade your display driver. Contact the supplier or manufacturer of your 



display adapter to check that you have the latest display drivers. Display drivers are 
normally provided free of charge from your Computer vendor. You can also obtain 
them for free by downloading them from the Internet (www.winfiles.com); you should, 
however, check that manually updating you drivers does not invalidate your warrantee 
or other agreement.

4.3 Text is missing or truncated

Some display drivers are designed to use large fonts. If your system is using one of 
these, any image in the main window will appear slightly truncated. Users can change 
this by selecting 'Settings' from the 'Start' menu, then by double clicking on the 
'Display' icon. Click on the 'Settings' tab, then select Small Fonts from the 'Font Size' 
drop-down list.

5. Problems with animations

5.1 General problems

As with section 4.2, Some color display adapters may display the title images 
incorrectly. If this happens, you should upgrade your display driver. Contact the 
supplier or manufacturer of your display adapter to check that you have the latest 
display drivers. Display drivers are normally provided free of charge from your 
Computer vendor. You can also obtain them for free by downloading them from the 
Internet (www.winfiles.com); you should, however, check that manually updating you 
drivers does not invalidate your warrantee or other agreement.
You should also try consulting Section 7, Running Out Of Memory or Running Slowly, 
for further advice. You should also check that the CD-ROM is free from dust and dirt, 
see section 2.1, Care of compact discs, for more information.

5.2 Solving problems with animation 

If you are running the title under Windows and have problems with animations (for 
example, jumpy animations, or distorted colors), there are two main steps you can try 
to solve your problems. Try the steps in the order given and stop when your problem is
solved:

5.2.1 Ensuring your display is using 256 colors or more,
5.2.2 Checking your display adapter's acceleration settings,

5.2.1 Ensuring your display is using 256 colors or more
1. From the 'Start' menu, select 'Settings,' then 'Control Panel.'
2. Double-click on the 'Display' icon, then click on the 'Settings' tab.
3. Check the 'Color Palette' setting to make sure that it is set to 256 colors or more.
4. If the setting is less than 256 colors, change it to 256 colors or more.



5. Click the 'Apply' button, then click 'OK.'

If this does not solve your problem, or if the setting is already 256 colors or more, then 
you should try any other available settings over 256 colors to see if they solve your 
problem.

5.2.2 Checking your display adapter's acceleration settings
1. If you have tried all the available 'Color Palette' settings of 256 colors or more, and 

none solve your problem, then you should click on the 'My Computer' icon using the 
right-hand mouse button, then select 'Properties.'

2. In the 'System Properties' box you should click on the 'Performance' tab.
3. In the 'Advanced Settings' box, click the 'Graphics' button.
4. In the 'Advanced Graphics Settings' box you should move the 'Hardware 

Acceleration' slide-control down to one above 'None,' then click 'OK.'
5. If this solves your problem you should try slowly increasing the 'Hardware 

Acceleration' slide-control until you find the point nearest to 'Full' at which your 
problem still remains solved. You will need to update your Video Card Drivers.

6. If this does not solve your problem you should put the slider back to 'Full,' and try 
the next step.

6. Audio problems

6.1 No sound output, but the product otherwise runs fine

There are many possible causes of audio problems. For example, your computer can 
only play one sound at a time, so when another application is playing a sound, the title 
cannot do so; you will get an error message in these circumstances. Most applications 
only prevent other programs from playing a sound when they themselves are doing so,
however, some applications, such as certain Screen Savers, remove audio capability 
from all other Windows applications. If you have such an application, you should turn it
off when you are running the title. 

If a sound card is not installed the title will not run correctly and you will not be able to 
here sounds. You should check that your computer has a sound card and drivers 
installed.

You should check that the speaker is hooked up to the jack on your sound card, and 
not hooked directly to the CD-ROM drive headphone socket. 

During Setup, special system software should be installed, and Windows should be 
restarted afterwards to make this software work. If you haven't already done so, restart
Windows now. 

If you cannot hear sound in the title, you can test sound in the following way:



1. From the 'Start' menu, select 'Settings,' then 'Control Panel.'
2. Double-click on the 'Sounds' icon.
3. Click on any item with a speaker next to it, then click the 'Preview' button.

If you can hear sound, there is some other problem with the title (contact Technical 
support who will help you solve this). If you can't hear sound, you may not have the 
correct sound drivers installed. Check with your sound card manufacturer to see if you 
have the correct drivers and that there are no hardware conflicts. If your sound card 
came with your computer, call your computer supplier.

6.2 Audio is fuzzy or distorted

There are a number of possible causes of fuzzy or distorted sounds. Problems are 
often caused by low quality speakers, speakers set to high or maximum volume, or 
speakers powered by batteries that are failing. You should also be aware that some 
speakers are not capable of playing low frequency sounds properly. If sound is 
interrupted, this may be caused by low memory – refer to section 7.

Some sound cards have software that allows you to adjust the volume AND tone of the
sound. If this is the case with your sound card, start with these tone controls set in the 
mid position and your volume level set at 50 percent. This should give a clear signal 
with no distortion. Check your sound card manual for the optimum settings.

Powered speakers are best and, if possible, should be placed either side of the 
screen. You may need to adjust the position of these speakers slightly if the magnets 
in the speakers are unshielded and cause discoloration and distortion of the image.

If your CD-ROM drive is not MPC-compatible, then the sound may play badly or be 
interrupted when playing. Check your CD-ROM drive's documentation to ensure that it 
is a double-speed, or faster, CD-ROM drive.

If you do have a double speed CD-ROM drive, and if you have no 'CDROM' icon in 
Device Manager (you can check this by selecting 'Control Panels' from the 'Start' 
menu, and by double clicking on the 'System' icon. Select the 'Device Manager' tab 
and check to see if a 'CDROM' icon appears in the list), then your machine is using 3.1
drivers to operate the CD drive. Consult your Manufacturer for the correct drivers.

6.3 Sound plays too quietly

Make sure the volume is set to an audible level. Check the sound card itself, the 
speakers or headphones if they have a volume control, and any software that may 
have been supplied with your sound card that can change the volume level. If there is 
a mute button in the audio software or on the speaker, check that this is not activated.

If the sound controls are set to an audible level, then you could try new speakers or 
headphones to see if they solve the problem.



7. Problems with QuickTime

QuickTime is a popular (and internationally recognized) utility for creating animations 
and movies within a title; it is capable of talking directly to your video card without 
going through windows. This means we can use higher quality smoother animation 
without sacrificing the overall speed of the program. Occasionally QuickTime will not 
function correctly with your video card.

7.1 How do I check if this title uses QuickTime?

There are two ways to determine if the product uses QuickTime.
· Look at the Minimum Requirements printed on the CD case. If you can see a 
Logo with a "Q" overlaid on four colored squares then your product does (ensure you 
are only looking at the PC section of the Minimum Requirements).
· During the installation a separate installer starts, mentioning that it will install 
QuickTime.

7.2 I already have QuickTime so I don't need to install it.

Wrong, You must install the version of QuickTime supplied with the disk. It will not 
erase your present version of QuickTime, mealy add to it. If you already have that 
exact version present all the installer will do is confirm that. There are currently 3 
versions of QuickTime available: QuickTime, QuickTime32 and QuickTime 3. They are 
all separate programs that do not interfere with each other. All versions can be present 
on your machine at the same time without any problems. Programs written for use with
a particular version of QuickTime will not work with the others. When you come to 
install QuickTime, do choose to check for existing versions, and subsequently choose 
to delete these files during the rest of the installation, if you are given that option. This 
will ensure that the files on your computer will be from the same installation (it only 
looks for an existing version of itself, not other types of QuickTime).

7.3 Product freezes up.

Because QuickTime can communicate directly to your video card, this can sometimes 
cause your computer to stop responding. The product will remain on screen but refuse 
to do anything. This is because your video card has become confused and has not 
completed an operation given to it by QuickTime, the software cannot continue until 
the video card completes it's operation.
If this happens restart your machine (use Ctrl+Alt+Del if necessary) then follow these 
instructions:

1. Go to your Control Panel (found in My Computer).
2. Double click on the icon "QuickTime".



3. Push More.
4. Click the Video tab.
5. There will be a drop down box headed Draw Method
6. Adjust the entry in the box to Raw Bitmap it's at the bottom.
7. Push Apply (you may need to confirm this)
8. Restart your machine in the usual way
9. If you have QuickTime32 in your control panel you will need to repeat these 

instructions substituting Quicktime32 for QuickTime in step 2.

This will cause QuickTime to talk to Windows instead of your video adapter. The only 
disadvantage is it may cause the product to run slower should this become apparent 
you will need to update your video card driver then reset your draw method (see the 
note at the top for updating your display driver).

7.4 Product causes a blue screen that starts "A fatal exception"

Should this happen it is due to exactly the same reason as above but this time you 
video card has tried to get windows to do something it can't. This has only ever 
occurred with the original QuickTime (still used today because it can run on Windows 
3.1 and Windows 95+). Please follow these instructions (if you are unfamiliar with 
Windows or are very new to computers, you may like to ring technical support who will 
go through this with you. You will not harm the machine if you make a mistake, but the 
product will not run):

1. First we need to determine that it is QuickTime causing this problem. Restart
your machine then double click on QuickTime in your Control panel (the 
control panel is found in Main for 3.x users and My Computer for other 
users). If the same error occurs proceed, if not, then QuickTime is not 
causing this problem.

2. You will need to restart your machine.
3. Double click on My Computer then the View menu, select options (Folder 

options on Windows 98).
4. Click the View tab. 
5. In the Hidden Files section ensure the Show all files option is selected. Push

OK.
6. Click on Start, Find then Files or Folders.
7. In the Named: box type: QTW.INI (ensure nothing else is in the box)
8. In the Look in: select (C:) or the option which contains that.
9. Place a tick in include subfolders.
10.Click OK
11. After a moment of activity it will find one file, double click on this.
12. It will open in notepad you need to adjust one if the lines. You should see a 

heading: 

[Video]



13. Immediately under this heading, you may have a line that starts (do not 
worry if you don't):

Optimize=

14.Carefully edit this line to read (make sure you type exactly as shown, note 
the spelling and capitalization. There are no spaces in the line):

Optimize=Raw

15.The two lines will should now read

[Video]
Optimize=Raw

16. If you make a mistake close the Window down (not saving changes) and go 
back to step 11.

17.Close the Window choosing Yes to save changes.
18.Follow steps 3,4 and 5 if you wish to re-hide system files.

8. Running out of memory or running slowly

The title uses your computer's system memory to display pictures. If you find that the 
title runs slowly or if you come across out-of-memory errors, the program probably 
does not have enough memory. Consider doing the following to improve your 
computer's performance:

· Users with no 'CDROM' icon in Device Manager (you can check this by selecting 
'Control Panels' from the 'Start' menu, and by double clicking on the 'System' icon. 
Select the 'Device Manager' tab and check to see if a 'CDROM' icon appears in the list),
then your machine is using 3.1 drivers to operate the CD drive. Consult your 
Manufacturer for the correct drivers.
· Quit any unnecessary applications, including any DOS Terminate and Stay Resident 
programs (TSRs) you may have installed. Check in your start up folder from your start 
menu.
· If the program is still running slowly, or freezes when you try to move to different 
parts of the program, you can improve its performance by selecting the 'Options' screen 
from within the title and turning off 'music' and 'auto-narration'.
· Check that your computer meets the minimum requirements of memory, the amount 
needed is printed on the packaging. Windows 95/98/NT users should right-click on the 
My Computer icon and select Properties. Check under the computer section. If you 
have less than the minimum of memory, then you need to install some more (this is not 
free, consult an independent computer consultant or your hardware vendor).
· Users should ensure that there is plenty of available hard disk space to allow the 
swap file to grow if necessary; at least 60MB is recommended.



· If you are running in color modes higher than 256 colors (8-bit), you should set your 
display to use 256 colors. Refer to 'Screen resolutions and color settings' in section 4, 
'Screen Display Notes,' for instructions on changing the color mode, but select 256 
colors.
· Speed up your hard disk by defragmenting it. There are a number of tools available 
to carry out this task, including the 'DEFRAG' command found in MS-DOS version 6.0 
and later.

9. Printing

Some titles do not have any printing functionality, consult the help guide within 
the product to determine if it can print.

Printing screens from the title may take several minutes, depending on the type of 
printer you use. Since screen resolution and printer resolution are often different, the 
printout may not match the quality you see on the screen. 

If you are not happy with the position on the page or the size of your print out, try using
the copy function to copy and paste the picture into another application such as a word
processor or paint package, before printing.

You can change the settings of your printer from within the title by clicking on 'Print' on 
the navigation bar, then waiting for the print dialogue box to appear. Click on 'Print 
Setup' to display the 'Print Setup' dialog box. (Please note: an explanation of the Print 
Setup dialog box is available in your Windows documentation.) 

Because the pictures can be quite large, you may have difficulty copying or printing in 
low-memory conditions. In this case, follow the advice in section 7 of this file, and try 
again.

If any of the following printing problems occur:

Nothing happens after the 'Printing' message
Corrupt output
Blank paper output

When any of these occur the following steps should be taken, in the order given. Stop 
when your problem is solved.

1. Try printing bitmap pictures from a different application to see if all printing is 
affected. Also make sure that you have the latest driver – you should contact your 
printer manufacturer or vendor to check this.

2. Try different modes of printing, for example, different print quality such as draft, fine, 
line art. The options available will vary depending on the type of printer (check your 



printer Setup documentation for information on how to do this).

10. Connecting to the Internet

Some titles do not have an Internet option form within the title. Most have the 
option to visit www.DKOnline.com from the starting (splash) screen. Consult the help 
within the product to determine if the product had Internet functionality built in.

Connecting to the Internet:
1. Click on the appropriate icon.
2. If an installed Web browser is detected on your machine you will see a dialog box 

asking you wish to use it.
3. If you select 'Yes' then you should be automatically connected to the appropriate 

Web pages. Your Web browser name will be stored so that subsequent connections 
will happen automatically. If you select 'No', or if an installed Web browser was not 
detected on your machine, you will be presented with a dialog box inviting you to 
browser for your Web browser.

4. If you're thinking of clicking 'Cancel' because you're not sure where your Web 
browser is located, you can try looking for it as described next:

a) Minimize the program, then double-click on the Start Menu on the Task Bar.
b) Select 'Find', then 'Files or Folders'. The 'Find' dialog box will appear.
c) In the 'Named' text field try typing netscape.exe if your browser is Netscape 

Navigator™, or iexplore.exe if your browser is Microsoft Internet Explorer™ (Be 
sure to look for iexplore.exe and NOT explore.exe).

d) In the 'Look in' field, ensure your hard disk is selected.
e) Next click on the 'Find Now' button.
f) The location of your browser will be displayed in a window in the lower part of 

the dialog box.

If your connection is not successful check the following:

 That you can connect to the Internet and use your browser in the normal way.
If you cannot do this, then there is a problem with your Internet connection. 
For example, make sure that your modem is correctly connected and 
switched on.

 Try starting your Internet connection and Web browser first, and then start up 
the title and try connecting the Internet.

If you select the wrong .exe, or simply decide that you'd rather use a different 
browser from the one you selected, then you can select a different browser .exe. You
can do this from the 'Online Setup' button.
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